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Housekeeping

¢ Introductions

e Pen/pencil, paper

¢ Cell phones

¢ Side conversations

e Questions

* Breaks

e Restrooms

¢ Do not park in side parking lot

¢ Do not wander around the building

¢ Incase of emergency
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Agenda )"‘m

(A
e Message Passing Skills " %ﬁ

Z

e Training
e |CS Forms

e Credential Updates

e Packet Network Update

e Monthly Packet Message Passing

e P1and HF Credentials & SHARES

e Weekly Packet Practice

e Safety Issue Observed: no fuses in power cables

e Working with a Served Agency
e W2XSC BBS Failure

Message Passing Skills

Can you send what the served agency needs?

Tim Howard, KE6TIM
Revised 10-Dec-2024

Why is Message Passing Important

* Trained Amateur Radio Operators
o Do more than push a PTT button.
o Know how to get agency specific messages from Point A to
Point B accurately and efficiently, even when other systems
are failing.

» No mater how much experience you have, your skills
become stale without practice.

* We encourage everyone to attend the training classes
every few years.

* We all think we are good enough, but how good is
good enough?

» Let’s try some examples.

* No judgement, just some fun to see what we can do.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 2
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Some Examples
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Santa Clara County ARES®/RACES

Message Handling
Procedures

Bavned: e 2024

https://www.scc-ares-races.org/operations.shtml#MHP

Message Passing Skills

* We schedule two Message Passing Classes each year.

o January 27t
o July 19th

* Quarterly Training Nets on the 3 Tuesday of the 1st
Month in each Quarter at 7pm on the Resource Net
Repeaters is another opportunity to learn and practice.

+ January 215t - details on web site--sign up.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 3
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Training

Judy Halchin, KKGBEWQ
Revised 22-Nov-2024

12/11/2024

Classes

* 24 training classes in 2024
* 16 unique classes

* 40 people in Introduction to Emergency
Communications classes
(not counting instructors and staff)

* 2025 schedule is very similar to this
year’s

Practices

* Monthly packet practice
* Pop-up packet drill
* Quarterly message passing practice

* Quarterly drills at County EOC radio
room

* Annual exercise in September

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Hospital Training

* Hospital employees got ham radio
licenses (or already had them)

* |CS-214 and ICS-309 training videos

* Basic voice and packet training for
hospital employees
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ICS Forms

Tim Howard, KE6TIM
Revised 10-Nov-2024
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Forms Updated in 2024

* In 2023 the Public Health Department relocated their
operations center and renamed it:
o Was: Medical Health Joint Operations Center - MHJOC
o Is: Public Health Department Operations Center - PHDOC

« This resulted in updates to Hospital Forms and the
Recommended Form Routing Sheet.

* We are still seeing numerous cases of MHJOC still being
used instead of PHDOC.

* The Recommended Form Routing Sheet is your friend.

Forms Updated in 2024 (Cont.)

* The RACES Mutual Aid Request Form was updated.

« The primary changes were on page two used at the
County EOC to assist with resource assignment and
tracking.

« Some changes on the front for cities.

* Those are used by city ECS/AECs and the changes
were shared with city RACES leaders at a quarterly EC
Council Meeting.

Errors in Form Completion

* We continue to see errors in form completion.

* Primarily 214 Activity Log and 309 Communications Log.

« Judging from the call signs, it is mostly newer operators;
but, some experienced operators also make errors.

« So new or experienced, we all can do better.

* These forms are legal documents and need to be
accurate.

* Let's review some of the more common errors to help us
all learn. Names have been redacted to protect the
innocent.

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 6
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What is missing or could be improved
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What is missing or could be improved
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Credential Updates

Tim Howard, KE6TIM
Revised 11-Dec-2024

Earned Credentials/Endorsements 2024

Credential | Field Operator | NetControl [Packet Operator Shadow
Type | 0 1 3 0
Type ll 1 1 0 0
Type lll 2 2 2 2

Type IV 2
Endorsement Earned

Mutual Aid C icator (MAC) 5

County EOC Radio Operator (ERO) 5

County EOC RACES Unit Leader (RUL) 5

Total Credentials and Endorsements

Number of Credentials Earned by Type

Credential \ Field Operator | Net Control | Packet Operator | Shadow
Type | 5 7 3 5
Typell | 17 1 13 9
Type Il 42 30 33 20
Type IV 54

Number of Endorsements Earned
Endorsement Earned
Mutual Aid Communicator (MAC) | 43
County Fire Station Radio Operator (FRO) (Pending) | 0
County EOC Radio Operator (ERO) 17
County EOC RACES Unit Leader (RUL) I 5

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Credentialing

12/11/2024

Credentialing in technical fields (usually called
certification) has been used for 25+ years to verify an

individual’s ability.

Credentialing is becoming more prevalent in Emergency
Management, especially where mutual aid may be

utilized.

The State of California has a credentialing program for

EOC positions and many cities are having their staff earn
credentials.

Served agencies are increasingly aware of credentialing
and are expecting team members to be credentialed.

Credentialing

Credibility: Credentials demonstrate your training,
knowledge, skills, and experience; and enhances

your credibility with peers and served agency
personel.

Commitment: Earning credentials demonstrates
your commitment to the EmComm role, validates
your acquired skills as a volunteer, and can open

doors to leadership and training roles within the
organization.

Assignments: Credentials can assure those that
assign you to a task know that you are capable of
handling whatever challenges the assignment

presents.

Credentialing Program Handbook

OV,

« .
; ~

h
D

Santa Clara County ARES®/RACES/ACS

Amateur Radio Operator

Credentialing
Program Handbook

on 313

Beved 6 Mac 1028

https://www.scc-ares-races.org/credentials/index.shtml#overview

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Database Update

12/11/2024

If you have a County DSW, the sticker on

your DSW Card Expires at the end of TH‘%&H :
December. DECEMBER
3
2024

New stickers will be provided to your EC SCC OEM
for distribution if you have updated your
database contact information by

December 31st,

Update/Verify Contact Info

My Contact Information

Personal Information

Call Sign* WeXRLE

First Name* Herman
My Profile Last Name™ Munster
My Contact Info Address 17 1313 Modangbed Ln
My Fquoment Address 2
My Activity Record ciy Mockingbird Heights
My Completion Certiicates state” ir3
My Credentils Zp" 00000

Emergency Contact Information
= Ly

1! 408-555-0001

2 : [408-555-0002
23 408-555-0003
maill 8 gmai.com

Contact number®  [408-555-1212

mail28 gmai.com
: lemail3@gmai.com

#17" :/408.555-1000
=~ : [408-555-2000

Yo astreviwed thisinformation on: 04/20/2024
e Fwviemest i Fifotation on i psge -

Save Changes,

Packet Network Update

2024 Year End Review

Jim Oberhofer, KN6PE
Revised 30 November 2024

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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Highlights -- Outpost and PackltForms

What’s in the box?

e SCCo Integrated Packet Installer 163C
*** PRERELEASE ***

e Qutpost Packet Message Manager
— GUI-based interface for managing packet communications
— Makes using packet as simple as using e-mail

® PackltForms
— Next generation HTML-based forms for use with Outpost
— Manual operation without Outpost

SCCo Installer v163C
September 2024

PacklitForm 3.16*

» Various forms and .pdf updates

« Even better manual operation support
« Auto-logging of sent and received messages
« Updated ICS-309 log maintenance
« Enhancements and bug fixes from user feedback

Outpost v3.8.6*
Resolves 3 reported defects; adds 6 requested changes, including...
« Signature update on the ICS-309 comm log
« Address book address expansion with sent messages

*See the release notes for details

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 12
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What’s new
(or 6 things to make your packet life easier)

Setting up Message ID prefix for Tac Calls
Packet Forms and Manual Packet
Message search

Monitor RF Packet Traffic

Fixing JNOS extra line feeds

Packet Field References

oV A WwN e

12/11/2024

1. Setting up Message ID prefix for Tac Calls

Situation: You are deployed with a tactical call. You get a call from the EOC that

the tac call message ID is not set up correctly.

Problem: Message IDs are both unique and help reference the sending station.

Solution:  With Outpost
1. Select Settings > Station ID...
2. When you fill in your FCC Call

ientncason | 885 Loging | Signatures |

sign, Outpost picks up the last Cuaret rome: om

Lo
I Ty

Usectame: Faimmam st

3 characters of your call as the
Message ID Prefix.

3. When setting up the Tactical Message D Preke [Rs (3 Characiss ma)

TransmaBST:

Call, you need to fill it in

Tactical
yourself.

5 Ust Tactkal Ol or s BES nteacton
4. Ask your shift supervisor or i

exercise coordinator for what Message D Fiec [
this field value should be.

Examples: Monthly Exercise: Tac Call=XND056 Msg ID Prefix = X56
City Deployment: ~ Tac Call=CUPDZA Msg ID Prefix = DZA

Hew

1. Setting up Message ID prefix for Tac Calls

Situation: You are deployed with a tactical call. You get a call from the EOC that

the tac call message ID is not set up correctly.

Problem: Message IDs are both unique and help reference the sending station.

Solution:  Manual Operations
1. Find and click on manual.cmd

D 122001

Santa Clara County ARES/RACES PackitForms

2. PackltForms picks up

User Ca Sign: weuais

the last 3 characters of your e —

FCC call as the Msg ID Prefix. et e e
3. The Tactical Call Msg ID Prefix 3 (e T ol 39

does the same, but may not be Tactical Call Sign: 005

correct. Tactcat Nova:_1amaa, Chackpoint 56

) ) l.u-hhd@uu—':mnm-y

4. Ask your shift supervisor or

exercise coordinator for what Archive Foider: €.\ fessages D014 18037

this field value should be AND T e

change this field if necessary. = — =

Examples: Monthly Exercise: Tac Call=XND056 Msg ID Prefix = X56
City Deployment:  Tac Call=CUPDZA Msg ID Prefix = DZA

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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2. PackltForms

e e . ]

——

MESSAGE FORM

S| s gt i e ] et o e o L FER =
S o S2Mta Clara County EOC Resource Request Form 213RR =
e T e T e P e
wsrou e -
- 2712 | S anta Clara OA Jurisdiction Status koo
© | ¢ Lot e o Sttt st ] et | o o AR s e
oo O bame: | O
sune 7| | comaet! 7™ Santa Clara OA Shelter Status w0 22014
e | Lttt (L] eoper] o] s e o o YRR e |
= = 3
contt| 2" Allied Health Status Report Short Form (oeoc-s) R e e,
Report o . Locati] 4e90090 N Gt b Gutpont ] St i s J] et e | o [ ISR Froper—
ot (© N ||
o iene | Coact . Santa Clara County RACES - Mutual Aid Request a4+

Prorty (€11 _ @ Routi (21

County Use of PackltForms

e Santa Clara County PackltForms contains these public forms
1. XSC Check-In/Out Message Form
2. XSCICS-213 Message Form adapted for Santa Clara County to
transmit messages.
3. XSC EOC-213RR Resource Request Form — Requests specific resources
needed to support an emergency.
4. XSC OA Jurisdiction Status Form — Reports jurisdiction emergency
situation status to county OEM.
5. XSC OA Shelter Status Form — Reports information and status on
shelters opened in the cities to county OEM.
6. XSC Allied Health Facility Status — Reports information & status of
private Skilled Nursing facilities to SCC Public Health Department.
7. XSC RACES Mutual Aid Request Form — Used by a jurisdiction to
request a RACES Mutual Aid.
e The SCC Installer program automatically installs these packet forms
along with Outpost.
— Additional forms may be provided by your EC

Updated PackltForm Defaults
packitforms ________Handiing Order[T0 ICS Position__[To Location _|

ICS 213 Message Form

EOC Resource Request 213RR - Planning Section County EOC
OA Jurisdiction Status Immediate  Situation analysis Unit County EOC
OA Shelter Status Priority Mass Care and Shelter Unit -
Allied Health Status Routine EMS Unit PHDOC
RACES Mutual Aid Request Routine RACES Chief Radio Officer County EOC
HAvBed Report Immediate  EMS Unit PHDOC
Medical Facility Status Immediate  EMS Unit PHDOC
Resource-Request Form#9A Obsolete -- Replaced by EOC Resource Request 213RR

e Aligns with the RACES Recommended Form Routing Cheat Sheet; updated March 2024

e Updates are in BOLD text

* Fields can be changed at message create time

o Always double-check the RACES Recommended Form Routing Cheat Sheet for your
specific situation

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 14
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Situation:

Problem:

Solution:

3. Message Search

This assignment has been in place for several shifts with plenty of
packet message traffic already passed.

Now, someone askes for a copy of a message you received. Where is
it?

1. On Outpost, click on the Search menu.

2. Enter some text that you know is likely part of the message, which
fields itis in (or
check all fields),
and whether you
want to check this

or all folders.

g [cur

w

Press Search

inckuge Biese beigs !}

4. For 1 All Folders, oo Ll )

Type field shows " MessageTed [ To !

the message L L )

: 9 6t Msten Tios i
location. ? Uskcries any single chisvacter

* MalENeS 2010 o Mace haraciers

% Reset o iston ciose

WIRSET

12/11/2024

4. Monitoring Packet traffic
Situation: Some users like to watch what is going on with on a frequency in
between Send/Receive Sessions to see if the frequency is clear.
Solution: 1. From Outpost, Tools > Interactive Packet > Serial / Com Port.
2. From Ipserial, Tools > Options. Check B "Turn on Packet Monitoring
(MON ON)...". Press OK.
3. When you press Connect, Ipserial.exe sends the MON ON command
to the TNC to start monitoring.
4. When Outpost starts a ]
Send/Receive session, it | e Fit ok
requires the serial port. oomed| it cresetesece|
« it tells Ipserial.exe to
disconnect.
« It opens the CR“ et by unpmst
and sends the necessary |\ Lk
TNC & BBS commands.
+ When done, it tells ves OFF
Ipserial to reconnect to
the Com Port.
‘Ew\e: sdiohe NG Saings S600.4 8157 Conen ont” o)
*hy
)
5. Fixing JNOS Extra Line Feeds By
e
Situation: JNOS causes message text lines greater than 127 characters to have a

CRILF inserted regardless of where it is in a sentence or word.
PackItForms handles this situation nicely. But what happens if an
Informal Message is sent? This is what it could look like...

B L e R O

From  XNOOSB@W 11 C Scc-ares-aces.org Local Msg ID: XND-2451P
To XHDEOC .

Suect  ¥56-172P_R_Obsentions from the fild

2.168

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved.
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*ag

- . DQILL by
5. Fixing JNOS Extra Line Feeds ’ﬁfl/:p,C

Solution:  If you come across this situation, try this:
In the message form, press View > JNOS Line Fix (BETA)
2. This change is not permanent and cannot be saved.
3. Pressing the forms’ Print button will print the original message.
e e o
From  XNDOSB@w lxsc scc-ares-faces.org Local MsgD: XND-2451P
To. XNDEOC

Suect  X56-172P_R_Obsenations from the fisld

, at approxima
Pleasent

at lea
levels of damace.

*ag

- . DQILL by
5. Fixing JNOS Extra Line Feeds ’*4/:,:,0*

Solution: 4. But, pressing File > Print will print the corrected version.

W6XRL4 as XNDO56

From: XNDOSE@wixse.scc-ares-races.org
To: XNDEOC

Sent: 1111812024 20:56

Recaived: 11/18/2024 20.57

Subject: X56-172P_R_Observations from the field
Local Msg ID: XND-245{P

6. Amateur Packet Radio

Field Reference, Type llI Amateur Packet Radio
Field Reference, Type Il

What is it

* an Unofficial SCCo RACES reference.

* Provides a reminder (job aid) for
how to perform tasks that need to
occur during a packet field
deployment.

¢ Helps ensure task consistency,
completeness, and operational
alignment with SCCo RACES policies
and procedures.

What it is not

¢ the only source of information on
which you should rely.

¢ an official SCCo RACES deliverable.

For SCCo RACES Responders

October 2024

@

)

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 16
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6. Amateur Packet Radio

Field Reference, Type llI Amateur Packet Radio
Field Reference, Type Il

Table of Contents
1 QUICK REFERENCE
2 INTRODUCTION
21 PURPOSE
22 W TO USE THIS HANDSOOK
PACKET OPERATOR CHECKLIST
PACKET STARTUP PROCEDURE
CLIENT SOFTWARE

For SCCo RACES Responders

October 2024

3
4
5
6

@

)

MESSAGE

STANDARD SUBJECT LINE FORM,
9 CHECK-IN, CHECK-OUT MESSAGI
10 RECOMMENDED FORM ROUTING

https://bit.ly/PacketT3

6. Amateur Packet Radio

Field Reference, Type I Amateur Packet Radio
Field Reference, Type Il

Table of Contents {
1  QUICKREF € For SCCo RACES Responders
2 INTRODUCTION 4
21 Pumsose b October 2024
22 How ToUsE THis HANDEOO ... 4}
'3 OmemR
3 MANUAL PACKET OPERATIONS. :
51 TNCCommanps ... f
32  BBSCOMMANDS..... —_— .| ((ZA?)
33 ConmecTing 7o THe TNCwrm PUTTY 3
3.4 STant or Smrr; Conmcure TNC SeTrings -y
35  Enpor Swrr: Restose TNC Sermnes . i
3.6 GETTING ALaDY FOR Manuat MESSAGING..... "
37 Manuar {
38 {

39 RECEVING A PAcxITFORM MESSAGE MANUALLY ...
3.10  Nores on OUTPOST TAG........
311 VIEWING SAVED MESSAGES
3.12  NoTES ON MaNUAL ICS 309 COMM LOG -or.vorcre oo

https://bit.ly/PacketT2

mpmp, P1 and HF
Credentials & SHARES

Mark Laubach, K6FJC
14-Dec-2024

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 17
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Monthly Packet Messaging Passing Practice
January to November stats

Not Held Not Held
Jan Feb  Mar Apr May Jun Jul Aug Sep Oct Nov Totals
Participants 24 21 19 20 16 1 16 27 15 169
Messages by participant by Type
Ics213 29 29 57 40 28 33 39 40 42 337
EOC213RR 20 1“1 19 27 21 112
Shelter Status 20 1 28 59
Allied Health Status 22 22
RACES Mutual Aid 2 1 37
csv 2 14 40
Op-to-Op & Other 281 249 205 7 38 216 311 208 1508
Total Messages 816 768 674 577 387 330 617 913 602 5684

You can review all past pn_'actice_s on the MPMP Training Page:

Packet Credential Changes

» Packet Operator Type | (P1)
« Removing: out of county assignments
* Moving out of P1 to a new area of focus:
« Setup, manage, and troubleshoot a JNOS-based packet BBS
system, running on Ubuntu, etc.
« Changing focus to W5XSC BBS to set up and operate for a training or
exercise event, with instructions from net team
« Refining knowledge items, digipeaters and nodes, and other problems
- Etc.
* Motivations
« P1 should be on parallel with other Type 1 credentials, e.g., specialist
and plan, design, deploy, train, ...
« It's a lot of work to complete existing requirements
« P1 credential != county BBS sysop
« Doesn't need to incorporate SCCo BBS sysop/network

* When: next Credential Program Handbook update

Member of County Networking Staff

« The network team is looking for a few “good people”
* In discussion likely in the form of a member of
network staff position posting (likely)
+ Discussed new endorsement not the way to go
« Recommendation from CRO and Pkt Manager
« Prerequisites: P2+, demonstrated team player
« Not for everyone, interview will be required with credential evaluator
and network team member — think of a position posting
« Successful interview,, candidate will be assigned mentor
« County BBS knowledge and demonstration (for all candidates)
« Building Ubuntu-based JNOS system to county configuration
« BBS JNOS sysop privileges demonstration, message and notice
management, log maintenance, Ubuntu tcp/ip networking, etc.
« Knowing what and what not to touch
« Additional skillsets desired among one or more of the following
* Network management, Network security, firewalls, monitoring, Network
routing, email (configuration, spam), devops, analysis, logging,
maintenance and upgrades, SCCo BBS operational knowledge, etc.

This is all under consideration and development
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Changes in County EOC Radio Room
HF Radio Remove / New State-funded HF Technology

« New radio technology has reduced the need for HF radio users to
deal with the complexities of HF propagation (solar conditions, time
of day, antenna orientation, etc.)

+ State has called this SHARES for SHAred RESsources
+ SCCo OEM has two rigs: EOC radio room fixed and mobile unit

« The use of new technologies all but eliminates the need to be
concerned about HF propagation for state-wide EmComm purposes.

« The need for a three level HF Credential is being removed from the
Credentialing Program and a “SHARES Radio Operator
Endorsement” is being added to the next version of the Credentialing
Program Handbook.

Changes in County EOC Radio Room
HF Radio Remove / New State-funded HF Technology

+ The “SHARES Radio Operator Endorsement” will be available to anyone
holding the EOC Radio Operator Endorsement.

« Early next year we will offer a SHARES HF Radio Orientation class for
those interested.

Quick Overview

« Based on Codan Communications equipment (Australia)

* Limited to state civil defense and emergency management agencies and some
select agencies within the state of California.

* Shared channels in the 2 to 8 MHz range. Access to 10 channels providing point-
to-point emergency radio coverage across the state. 24x7 Link Quality Analysis
and Automatic Link Establishment to eliminate ToD propagation concerns

* Operates in accordance with FCC Rules Part 90 — Private Land Mobile Radio
Services (primary) and Part 97 Amateur

* All ”push button”

SHARES Base Station HF Equipment

]

Pactor Modem

Desk
Console
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SEMS - Reminder

Standardized Emergency Management System

' OES Region

A .v E \‘
— | Operational
Area/County

Local

& gIt
Government
| Field (IC) /City

12/11/2024

SEMS General Flow of Requests and Resources

¢ OA encompasses a county
¢ 58 counties

* Six mutual aid regions

NOTES
* Local governments may request

mutual aid directly from other
local governments where local
agreements exist.

fa
Unaffected Local
Operational Governments
Areas in OA

« Discipline-specific mutual aid Unaffected

systems may have procedures
that provide additional methods
of obtaining state resources.

* Volunteer and private agencies

Governments
InOA

may be involved at each level.

Weekly Packet Practice

Steve Roth, KC6RSC
Revised 11-Dec-2024
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12/11/2024

\\EVV va W YYY

—

Weekly Packet Check-Ins
(Unique Call Signs)
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Multi-Year Comparison

[ [2018 12019 ]2020 ] 2021 |2022 |2023 ]2024 ]

Total Messages 2116 2844 3138 3226 3200 2932 2408
% Correct 932% 93.7% 955% 96.6% 88.4% 83.1% 98.3%
Unique Calls 255 29 31 30 274 343 32.0

Mailbox Full — Now What?

You are assigned to a rarely used station.
You connect to the BBS, and it has 142
messages waiting. That will take forever!

1. Abort the connection
2. Switch to alternate BBS

3. Connect manually, list with LL. If the
backed-up messages are obsolete or
unimportant, kill them with K.

Can’t Wait for Bulletins to Download?

You’re waiting for a critical message but
Outpost wants to download the XSCPERM
bulletins. That will take too long!

1. Abort the connection
2. Outpost: Setup - BBS - Receiving

3. Turn off “Retrieve Bulletins” checkbox.
(Don’t forget to turn it back on later!)
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Switching between RF and
TCP/IP network access
in Outpost

Using Profiles extensively

Andreas Ott, K6OTT
Revised 11-Dec-2024

BBS settings and access paths

Teene (0 1
. you are in an EOC or tactical location _— ﬂ_?f
. you know your primary and secondary e
BBS, your tactical call, your FCC call — 2mi12%0 M,
and know how to configure all this in

Outpost

. your main access to the BBSen has
been over RF

. you recently got connected to the
SCCo Systems TCP/IP Subscriber
Network (or your EOC location has

a wired Ethernet connection to our
network)

Workflows on RF

. No Issues: you are using your primary BBS over RF

. primary BBS “unreachable”: you manually switch to the
secondary BBS, and announce this fact on a net to the
County EOC (and other stations) so that they can adjust
sending you messages to your secondary BBS address

. primary BBS “reachable”: you have the choice of
continuing on the secondary BBS or switching back to
the primary BBS (same..., announce it, so others know
where to find you)

— your easiest way of “switching around” is by using
Outpost Profiles
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Create RF Profiles

. the default Outpost profile after new install is “Outpost”

¥ actensHelp
| _mechive | Detete | prct | search | Senomecene | prowe IR -

o
In Tray [T Tspe [ From [ | 88 |tocali® | Subjed

. create new profile (naming convention below)

. for your primary BBS, device and StationID

. testit!

. repeat for your secondary BBS, then test some more!

. practice switching between profiles, do not forget to
“switch” and verify the radio frequency at the same time

. switching between RF bands on the same BBS without
changing the profile

Profile Parameters

. BBS name
. device/connection
. Interface name
. StationID
(your callsign, tactical or FCC)

. Create, save as (use ~ in profile name as separator)

Examples:
. W1XSC~KPC3~COM5FTDI~K60TT
« WIXSC~TELNET-W1XSC~K6OTT

Parameter details

< Station ID

TNC/ComPort >

finally: Save it

3 Outpost Packet Message Manager

| | sesch | sensmecois | Protte.[WiXSC-KPCI-COMEFTDI-KAC o]

PC Time Check.

Sentlisgr T WORGEWSl  Ddae
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Create Telnet Profile

. for your primary BBS, telnet connection and StationID

. add username and password, remove colon “:” from
password prompt field

. testit!

. repeat for your secondary BBS

. test some more!

. when switching back to any RF profile, do not forget to
“switch” and verify the radio frequency to match the
BBS frequency on that band at the same time

Telnet details

3 Bt et o LAY OIS

W

IP, port >

prompt >

BBS username
and password >

Workflows on Telnet

No Issues: you are using your primary BBS over telnet
primary BBS “unreachable”: you manually switch to the
secondary BBS, and announce this fact on a net to the
County EOC (and other stations) so that they can adjust
sending you messages to your secondary BBS address
primary BBS “reachable”: you have the choice of
continuing on the secondary BBS or switching back to
the primary BBS (same..., announce it, so others know
where to find you)

— your easiest way of “switching around” is by using
Outpost Profiles
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Switching around

12/11/2024

Always verify Outpost status bar on the bottom

References

For Outpost, see training slide decks from SCCo

ARES/RACES Packet Operations classes

Packet Operations - Type lll, Part A
Packet Operations - Type lll, Part B
Packet Operations - Type |l

and of course the Outpost Documentation

Safety issue observed:

no fuses in power cables
Batteries are no fun

Andreas Ott, K6OTT

Revised 11-Dec-2024
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Energy content in a battery

e Energy content in a (SLA) battery:
3.6 * voltage * mAh = Energy [Joule]
Example: SLA 12V@18Ah
3.6 12 * 18,000 = 777 kJ

(approximate energy needed to boil 1/2 gal of water
from room temp)

e Energy density in LiFePO4 battery:
> 3x of SLA battery by weight, also
higher load current possible

The Big Short

Now picture this: if your battery shorts
out, you will set free most of the energy
in a fraction of one second (aka. boil
the water in < 1 second). Until
something fails, such as the wire
melting, or the battery liquids heat past
their boiling point, with “steam” quickly
escaping.

Rapid Unscheduled Disassembly

Escaping electrolyte steam usually leads
to the entire battery exploding. [*]
Good engineering practice is to insert
something into the circuit that will fail
before it turns into an incident,
preferably a protective device such as a
fuse. “All circuits shall have fuses”.

* “Don’t try this at home - go to a friend’s house.”
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Fuses to the rescue

DC power
supply cable
(ac:elssory)

Fuse holder

Power cord (DC

(direct current) b
13.8V) Iﬂ::@ 54

Rear side of main body

SON
he)
&J

image credit: KOBG/Yaesu

Protecting battery and load (equipment)

—

Charge controllers with
electronic load limiters

Check the manual: They will recommend
minimum wire sizes and fuses, at least
at the battery and the power source!

image credit: Renogy

DC Load: e 1] | '
20 aMps | | ool |
cutoff :

Working with a Served Agency
Golden Eagle 2024

Jeff Grafton, AJ6XZ
Revised 10-Dec-2024
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Golden Eagle 2024: Hellyer Park C-POD

* Simulated M7.5 earthquake

e County OEM established Type Ill C-POD
in Hellyer Park
* Simulated cell phone outage at site

* RACES mobilized to provide comms
between C-POD site and EOC

Golden Eagle 2024: Hellyer Park C-POD

Golden Eagle 2024: A few surprises

* RACES wasn’t in the org chart...
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Golden Eagle 2024: A few surprises

.. or the
site map

~‘v W ,

A
e I it

Hellyer Park Cottenwood Parking
G e Giter R Lot C-POD Map

Golden Eagle 2024: Field Setup

Golden Eagle 2024: More surprises

* FRS radios were used for
on-site comms

* The IC expected RACES
would handle all commes,
including FRS

* RACES staff had not been
briefed on use of FRS
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Golden Eagle 2024: Message flow

* Many incident staff (including IC) were
unfamiliar with forms and message flow to
EOC

* RACES provided
blank forms and
coaching

« Handing off the
Recommended
Form Routing
Cheat Sheet
worked wonders

Golden Eagle 2024: Operations

* RACES sent and received multiple 3-

party messages over packet and voice
* 1CS-213

e 213RR with routing slip

* Informal

* Cross-trained operators

* Able to fill in while others were coaching
incident staff or taking breaks

Golden Eagle 2024: Takeaways

* Exercising with served agencies is
invaluable

* Keep current on training and practice so
you know how message flow works

* Semper Gumby!
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W2XSC BBS Failure
June 8th — 16th

Tim Howard, KE6TIM
Revised 16-Nov-2024

Initial Evaluation
* Problems with W2XSC were reported

* A number of remote troubleshooting steps were taken.
o The network connection between the BBS PC and
the other network infrastructure at the site had failed.
o The JNOS BBS, the TNCs, and the Radios were
fully functional.
o The BBS was usable as a standalone BBS without
external connectivity to the rest of the network.

« It was determined that a spare computer, data switch,
and data cable should be taken to the site.

« Because of the remote location of the site, other parts,
tools, and equipment were collected for the trip.

Plan for Trip to Site

* Over a one hour drive one-way

« Take anything you might need. Spare parts for repair
and also backup monitor, keyboard, mouse, tools, etc.

« Need a high clearance vehicle in good weather, 4WD at
other times.

« Because of the remote location we want to send at least
two people.

« It took a couple of days to get the material together.

« The keys to access the site were not readily available.

« Once on site, it was quickly determined there was a
cable issue.
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Initial Visit

« Cable was replaced

« TNC Firmware updated

« General cleaning and
inspection of cabinet

* Remote testers
checked all radio, BBS,
and email connections
to the site

« The site was up and
back to normal
operation

Less than 16 hours later

* The BBS failed with the exact same symptoms. Remote
diagnostics indicated a similar failure.

« Asecond visit the next day was scheduled with spare
parts, a hardened data cable, and mouse deterent.

OCK KILLS % 12 MICE®

* The same data cable was chewed breaking wires
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The data cable was replaced with the shielded cable.

No additional problems with mice eating cables

Site owner has placed more traps and sealed any
openings found. Reminded tenants to keep door closed.

Thanks to:
Thomas Leibold — spare parts and technical expertice
Bertrand Achard — extra tools and computer monitor
Tim Howard — driver and support

12/11/2024

Additional W2XSC Issues

PG&E PSPS power shutdown
o Generator started but shutdown failed due to
overheating
o Fan Blades were broken providing no cooling air
o Mice or larger rodents had got inside the fan shroud
and when engine started the fan blades broke off.
o Our batteries did not work due to several years of use
with numerous PG&E and generator issues

Site owner has enclosed all openings to the generator
with wire mesh to allow air flow but block mice and other
rodents from access

New batteries are on order and when they arrive a site
visit will be scheduled

Q&A

All Training Staff
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Thank You!

Please check your email and follow the instructions to
complete and return the Course Evaluation.

To get course credit the Course Evaluation is due by next
Saturday.

If you have questions or feedback about this or other training activities,
you can join our Training discussion group.
https://scc-ares-races.groups.io/g/training

This is a moderated group.

See you at a training class or exercise next year!

Copyright 2024 Santa Clara County ARES/RACES. All Rights Reserved. 35



